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Section 1: Main Screen Operations 
 

Startup 
 

This is the startup screen.  It gives you two options to begin a new decision pad file: New Decision, or Open 
an Existing Decision. 
 

 

For a new decision project you can open a ‘New Blank Decision’ that will begin with an empty 
matrix screen like this: 

 

Note: For more about the matrix screen see p. 5.  If you are new to DecisionPad you might 
want to read through the Tutorials. 

Or you can begin your DecisionPad file with a ‘Decision Jumpstart’.  A Decision Jumpstart allows 
you to go to a self-explanatory Wizard to help you quickly build your first draft of the decision 
structure.  The Jumpstart option begins like this: 
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If you want to open an existing file, click ‘Open File’ to open one of the sample files or your own.  
Or click ‘Open Last’ to open the last file you worked on in DecisionPad. 

 

Main Screen Matrix 

 

 

The Matrix view is the heart of the structures for DecisionPad.  This is where alternatives are 
evaluated against weighted criteria.  Referring to the screenshot above, criteria are the rows in the 
matrix.  Such as “Quality” or “Dependability”.  Alternatives are the columns, like “Gates by Sally” or 
“Welders Anon.  The cells of the matrix show your assigned values like “High” or “Good”.  At the 
top are the current and previous rankings.  Weights are listed in a column between the criteria 
names and the values. 

When you start all the cell values will be listed as question mark (?).  As you go through your 
alternatives criteria, the question mark will be replaced by values.  As long as there are question 
marks in the matrix the scores listed along the top will show a range of possible scores; the ranking 
is based on the average scores.  As more values get set the ranges narrow.  Often, at some point, 
a winner emerges regardless of what the remaining question marks might be. For example if there 
are still question marks (?) remaining for “Fred’s Iron Works”, this may lead to a score range that 
cannot beat “Welder’s Anon”. 
Items in the matrix with notes attached, like Fred’ Iron Works above, are indicated by the ♪ symbol.  
You can hover the mouse over the item showing the ♪ to see it pop-up, or use the right-click menu 
following to attach or edit a note. 
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If you right-click on the Matrix you will get this popup menu. 

 

The first ten items are the same as the main Edit menu starting on p. 14.   

Sorts Alternatives and Sorts Criteria set rules for how the matrix is sorted with a flyout menu.  The 
flyout menu view is re-sorted every time something in the decision model changes.  Here the 
alternatives are currently unsorted, in the same order as the tree at the left of the screen.  They 
could also be sorted by rank, by the selected criterion’s scores or alphabetically.  To find more 
detail about these options see the View Properties topic on p. 23. 

 

Tree View 

 

 



DecisionPad 3 Reference Guide – 11/20/08 – © 2008 Apian Software Inc – Page 7 of 33 

The tree view shows all the components of the decision.  There is an Add to Group at the end of 
each group, and an Add at the end of everything for top level items.  Note the optional outline 
structure for Criteria which can be nested as deeply as you like.   

You can double-click on items in the tree to edit their properties.  With the exceptions of View > 
Matrix, Scale > Comment and the four default Text Styles you can drag-and-drop items within a 
list, such as reordering the alternatives or moving a criterion to a different group level.  

When a report is displayed instead of the matrix, all the editing is done through tree selections.  
You can make selections in either the tree or the matrix for editing.    

The squares and folders next to the items in the tree give you clues to aid navigation and editing.   
Alternatives, Criteria and Views show yellow squares.  The groups for Criteria have yellow folders.  
Scales and Text Styles show a green square when they are used in this decision or an empty 
square when defined but unused.  Add items also have empty squares. 

If you select an item in the tree it will get a red border.  If you make a selection in the matrix, all the 
tree items associated with it will be marked with blue borders.  In the example above a matrix cell 
was selected.  If you are working with a large matrix, it is sometimes faster to select an item in the 
tree that is off-screen rather than scrolling through the matrix. 

If you right-click on a Tree item you will get this popup menu: 

 

The first eight items are like the main Edit menu starting on p. 14.  The last two provide an easy 
way to move items up or down the tree.   

The Tutorial Guide has a section on using criteria groups which shows how to use these “outline 
editing” features. 
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Toolbar Buttons 

 

 

The buttons from left to right are: 
 
File Open and File Save 
Print, Print Preview and Page Setup 
Cut, Copy and Paste 
Undo and Redo 
View Properties 

 

Auto-Save Files 
 
After about 15 minutes of making changes to a new or just opened file you will get the Auto-Save 
dialog: 
 

 
 

You can click the Save Now button to save this project to disk, which acts like a File > Save if the 
file already has a name or like a File, Save As if it is a new one. 

The Save As Now forces a new file name for your edited decision project. 

The Wait button is like a snooze alarm.  It does nothing now but waits about 5 more minutes and 
reminds you again. 

The Do not show again checkbox applies only if the file is actually saved.  If you press Wait it is 
ignored.  If you were to click one of the Save buttons with and check Do not show again, after the 
next 15 minutes of changes the file would simply be saved without asking again. 
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What if it “doesn’t make sense?” Checklist 

 

DecisionPad is a communication tool that helps organize the reasoning behind a decision and 
explain it to the rest of the organization.  When a decision “does not make sense” to you then it is 
time for a little troubleshooting – until it explains the reasoning clearly to you it certainly will not be 
clear to anyone else.  Here is a checklist to review for any decision before it gets distributed: 

(1) Check the scales for the criteria – have the right ones been applied?  Is the best-worst 
sense correct?  Do the number or date scales have appropriate end points that do not 
overstate or understate the usefulness of the alternatives? 

(2) Open the weights report – do the weights look correct?   

(3) Open the Weight Sensitivity report and scroll to the end.  Do the criteria score ranges 
reflect the differences in the alternatives? 

(4) Are there too many unknowns in your decision?  Does the amount of unknowns cause 
a wide range in scores which makes the ranking not useful? 

(5) Turn the impact arrows on – do any of them surprise you?  They might indicate a 
weight or scale issue missed earlier. 

(6) Is a criterion missing? 

The last one happened to us putting together a model for our business.  When we got “done” it 
came up with a very non-intuitive answer.  After some thought, we realized that a criterion had 
been left out.  After we added the missing criteria our decision fell into place.  Imagine trying to 
explain that recommendation, with or without DecisionPad, before realizing we had forgotten one 
of the critical factors? 
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Section 2: Main Menus 
 

File Menu 

 

New Blank Decision: 

Provides an empty decision matrix to which you add criteria and alternatives directly. 

 

Decision JumpStart: 

JumpStart is a self-explanatory Wizard to help you build a matrix following the instructions on each 
screen. Think of JumpStart as a way to develop a rough draft.  You choose a decision type which 
is followed by several screens of typical criteria.  These suggestions can be used verbatim but are 
really intended to stimulate your own thinking about criteria for your own decision.  Then JumpStart 
helps with scoring, scales, weighting and the addition of alternatives.   

At the end you have a matrix to begin the detailed thinking.  If some information is not available or 
controversial you can leave it for later. 

 

Save, Open and Close: 

DecisionPad files are xxx.dp3 with the most recent automatic backup as xxx.dp3.bak.  Selecting 
Close from the file menu closes the entire DecisionPad file.  Closing a .dp3 is not the same as 
selecting File > New Blank Decision. 

Also see the Autosave rules on p. 8. 

 

Printing: 

When printing from the Decision Pad file the matrix or report view active on the main screen is the 
one that will be printed.  Your DecisionPad printing layout can be formatted by using the File > 
Page Setup and/or View > View Properties for layout instructions and to adjust page margins.  

The Print Preview screen has a print button that sends the entire document to your default printer.  
For control of which pages will print and to what printer, use the File > Print menu. 

While in Demonstration Mode a “watermark” will print over the pages.  The watermark will 
disappear in licensed installations. 
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Project Menu 

 

Scoring: 

 

The choices here determine how the values for alternatives and criteria will be evaluated to provide 
the rankings: 

Weights → How important each criterion is 

Scoring → How useful the criterion’s entry for an alternative is 

For weights there are three approaches: 

Numeric weights are assigned the each criteria and then sub-totaled through groups to a 
grand total at the bottom of the matrix.  Numeric weights must be positive numbers or zero.  
After setting the relative weights you can force the total so your weights can be expressed 
in parts of 100 or 1000 for ease of human understanding, although only the relative weights 
matter in the analysis.  The weights are applied to the scores for each cell to produce the 
alternative’s total score in a weighted-score analysis, or in full PhD-speak a “multivariate 
weighted utility analysis”. 

High-Low Weights use words instead of numbers.  Internally the evaluation algorithm 
converts them to numbers using the Ratio specified.  The Ratio is set to 3 by default as this 
seems to fit people’s expectations but you are welcome to change it to anything between 2 
and 10.  Generally speaking word weights are best with no more than one grouping level; 
for deeper nesting like Analytic Hierarchies use numbers or points. 

Points assigned to each criterion are also sub-totaled and totaled.  The difference from the 
two methods above is that the Total Points will be shown instead of the Total Scores at the 
top of the matrix.  The evaluation for a scale’s answers says how many of those points are 
given and is expressed as 0 to 100%.  For example if ‘Good’ is 60% and the criterion gets 
20 points then that alternative receives 12 points net.  Negative points are allowed in the 
point totals although these should be avoided if possible because the subtotaling process 
can become confusing.   

Mathematically, except for roundoff differences, these methods all produce the same rankings.  
However the people in your organization may be familiar with an evaluation method that adds up to 
250 points or does scores from -5 to +5, so the DecisionPad matrix will be clearer if it uses these 
instead of the default 0-10 scores.  One less impediment to getting the decision made. 

If you select Numeric or High-Low weights then the next choice is the Scoring.  The default range 
is 0 to 10 but you can use any range you like so long as the low score is numerically less than the 
high score.  The absolute numbers do not matter in the ranking analysis; only the relative scores. 
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The conversion of a criterion’s entries to scores or point percentages is set by the Scale assigned 
to each criterion.  For more on Scale scoring see p. 27 or the Tutorial Guide Scales and Scores. 

Enable Must Have Qualifications adds a column to the matrix where a minimum acceptable value 
can be set for one or more rows.  Any alternatives whose value is unknown or scores less than the 
Must Have will be marked DSQ for Disqualified in the rankings and with a red X next to its value in 
the matrix.  The total score or points will still be computed.  Sometimes you will find a disqualified 
option scores well otherwise, which might suggest renegotiating that requirement.  Must Haves 
cannot be applied to scales that do not consistently get better or worse. 

It is important to separate a Must Have from Scoring to avoid skewing the analysis.  For example, 
say you were looking for office space and your theoretical requirements were 5000 square-feet, 
with anything up to 8000 square-feet being better (to be balanced against the cost and other 
factors in DecisionPad of course).  You would setup the scale to rate the sizes over a larger range 
to accommodate some options at 4500 square-feet or 9000 square-feet, then set the Must Have at 
5000 square-feet which would disqualify the 4500 square-feet property.  However you might 
discover that if you told DecisionPad to ignore that limit the 4500 square-feet property would 
become the clear winner.  Now you have the option to be creative to see if there is a way to make 
4500 square-feet work (like paying for offsite storage) instead of blindly accepting what may have 
been an arbitrary assessment originally. 

 

Overall Notes: 

 

 
Overall Notes capture information about the decision structure, the documentation process and to 
clarify elements of your reports to your audience.   

Select the note category from the list and then type into the Edit box.  The color, bold, italic or 
underline settings within the note will be applied to what Text Style is selected in the View 
Properties for a particular report. There are Paste and Paste Unformatted buttons for a choice of 
whether to paste with text formatting or without.  Generally the Unformatted one is best coming 
from another software product to give you DecisionPad global text style control. 

You can also attach notes to alternatives, criteria or value cells in the matrix.  Any of the notes can 
be shown in the report views. 
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Text Styles: 

 

 

Changes to the Text Styles are saved as the changes are made, so this selection dialog only has a 
Close button.  The first four names are built-in.  These four may be copied or edited but not 
deleted.   

The buttons above the list specify the editing action:  pencil point to add a new one, pencil body to 
edit the selected style, pencil eraser to delete an unused style or camera to copy the selected one.   

Editing will be with the Text Style definition dialog described on p. 33 

 

Logo: 

 

 

 

Your logo image is available for printing with any report or matrix.  To replace the “your logo” 
placeholder we supplied, click either the File or Paste buttons.  Either way a copy is made into the 
DecisionPad project file, so if you change a logo image file you need to return here to re-import it.  
The image is shown here at full-size; you can adjust the size in any View where it used. 
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Edit Menu 

These items apply to the tree or to the matrix view.  Generally speaking the Report views are not 
editable directly, only through their View Properties.  The Matrix also has View Properties. 

 

Undo and Redo: 

Each time you edit something a snapshot is taken of the decision structure.  The most recent 
dozen snapshots are kept and you can undo or redo within that set. 

 

Insert: 

This has a flyout menu for what to insert: 

 

These may not all be enabled, depending on what you last selected in the matrix or tree.  They will 
bring up an empty definition dialog appropriate to each type.  See the Definition Dialogs section. 

 

Edit: 

Brings up the definition dialog for whatever is selected in the tree or matrix.  See the Definition 
Dialog section about them. 

 

Clear: 

 

This is the way the dialog would appear if a matrix cell was selected, giving you a choice of 
clearing the value and note for that cell, or its alternative, or its criterion.  If the selection was on an 
alternative or criterion label in the matrix or tree only one choice would be available. 

Only the Values and the notes attached to the Values will be cleared.  The alternative, criterion or 
any notes that are attached to them will not be cleared. 
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Delete:   

The Delete menu option pops up a confirmation dialog for whatever was selected before removing 
it.  You may not be able to delete certain built-in items like the Comment scale or any scale or text 
style in use. 

 

Cut or Copy: 

Puts the object selected on the clipboard in DecisonPad format, and when appropriate with a text 
version.  If you cut or copy an Alternative, its description and all of the values in its column go to 
the clipboard as text.   

 

Paste: 

Paste uses the selection in the tree or matrix as its insert point if there is a compatible object on the 
clipboard.  If you cut or copied an alternative the paste function will insert the alternative and all of 
its data.  If you copy and paste an alternative the name will be changed to “Copy of” and a new 
alias given.  Similarly for criteria, scales or text styles. 

If there is just text on the clipboard when you paste to alternatives or criteria, that text will name 
new alternatives or criteria, separating the names at line breaks or tabs in the clipped text.  For 
example, if you already have a list of alternative names in Excel, you can block copy and paste 
them into DecisionPad to quickly create the alternatives.  With Criteria they would be named 
without scales which you would assign by editing in the usual way. 

 

Values Button Set: 
 
When a criterion’s scale has discrete values – keywords, ratings or rankings – they can be set 
using an array of buttons: 
 

 
 

Each row is an alternative, and the buttons are labeled with the possible values.  The [?] button 
means no value, an unknown. 
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The three Sort buttons at the top let you reorder the rows as much as you wish.  A common 
practice for subjective values is to quickly make some settings, then click Sort and see if they are in 
the order and with the profile that makes sense to you.  This is particularly helpful in meetings as 
the participants talk through each criterion. 

 

By Pairs lets you set relative values for criteria two at a time.   

 

Moving the sliders lets you reflect the relative usefulness of the alternatives for this criterion.  As 
soon as you set at least one comparison for each alternative the Finished button becomes 
enabled.  You can then do as many more as you wish; more will refine the relationships all the way 
up to the maximum which compares every alternative against every other.   

Paired settings help make a good first draft, by being the easiest way to get a first cut at the values 
with a modest number of alternatives.  Generally you will want to fine-tune the results in the button 
setting screen so the profile reflects your evaluations rather than just accepting the paired results. 

The Next Button allows you to easily navigate through your alternatives to adjust value settings 
without having to return to the matrix screen each time. 

 
Weight Slider Set, Point Slider Set or Weight Button Set: 

For numeric weights or for points you will set a sliders screen like this: 

 

The sliders are a great way to set the relative importance of a set of criteria.  You can quickly set 
your first impression, click Sort for the profile, adjust, Sort again, until it represents your 
requirements. 
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The total within this group is shown along with a New entry and Set button to force the total.  
Generally this is the last step after the relative importance has been set. 

By Pairs operates the same as for Button Values on p. 16. 

When the criteria are grouped each setting screen is either at the top level or within one group 
such as the example here.  It works at that selected level which may be all criteria, all groups or 
some mix of them.  This will be clearer if you look at the criteria groupings in the Tree View.  Each 
weight screen is for a node of the criterion tree. 

If the weighting uses words instead of numbers it will present a button screen that operates as 
described for values starting on p. 15. 

 

Add to Experiment: 

This is used to take Snapshots of what-if changes for a tracking report.  To start this process see 
Views, New Experiment Report on p. 18. 

 

Prune Alternatives: 

 

  

Prune Alternatives provides a way to remove alternatives according to a rule.  Which rules are 
enabled will depend on the current state of the matrix.  For the example above, the Must Haves 
were enabled in Project > Scoring so some alternatives were disqualified, otherwise those DSQ 
choices would be disabled. 

The Best selection will keep at least as many as selected and allow for decision ambiguities due to 
unknown variables.  In other words it keeps all those which could be part of the top number.  You 
may ask for the top three but find several more are kept because they could also be in that top 
three, depending on how the unknown (?) values turn out. 

The First selection simply takes alternatives top down in the tree.  Rather than delete a lot of items 
one at a time it may be faster to drag the keepers to the first part of the tree and prune it. 
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View Menu 

 

View Properties: 

Brings up the View Properties dialog for the currently selected matrix or report view.  See the 
definition dialog on p. 23  for more. 

 

New Matrix: 

Brings up the View Properties dialog to define a different matrix view than the built-in one.  You will 
have flexibility in the rows and columns that are visible and their order. 

 

New Report: 

First pick the type of report you want from the flyout menu which brings up the View Properties 
dialog.  Then you can refine its appearance. 

 

New Experiment: 

This is a special kind of report which starts a “what-if” recording process by capturing the current 
state of the decision as a Baseline: all of the weights, values and scoring.  Then as you make 
changes their effect is tracked for you and displayed in the Experiments report.  This can be helpful 
in showing the decision thought process -- such as dealing with controversial items -- when 
explaining the recommendations. 

Once you have created the Experiments report, which starts out empty, you make what-if changes 
to the decision.  When you get to a new configuration of interest, use Edit, Add to Experiment or 
the F11 key to capture it which brings up this dialog: 

 

DecisionPad will take a snapshot to show any changes from the Baseline in the Experiments report 
when you click OK. 
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The Step Name is required because it will head the changes column in the report. The Note is 
optional.  Keep the Step Name short – often the suggested “(1)” is enough – and use the Note for 
more commentary since the exact changes will be tracked for you 

In the What’s Next section you can elect to have DecisionPad Revert to the Baseline after this step 
or keep on with a progression of changes.  You can also indicate when you want to End the 
Snapshot Captures.  This gives you the option when done with the captures to return to the 
baseline or not. 

After each capture, the Experiments report will update to show what you have done so far. 

 

 

Open Window for View: 

If you have closed the window for a View but have not deleted it, then this lets you re-open the 
window. 
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Section 3: Definition Dialogs 

Alternative Definition 
 

 
When defining an alternative the Name field is the only thing that is required.  The Notes field is for 
optional comments on each alternative that can be displayed in various reports.   

Tip:  It is best if you keep the alternative name short and put descriptive details in the note. 

The Alias is a way to publish anonymous reports, like showing vendors how they ranked without 
revealing who their competition was.  The Alias name is automatically generated with random 
characters that do not match any other alternatives. 

The buttons next to the name allow you to Cut, Copy and Paste in the Name field.  The buttons 
above the Note allow modifications of the font.  Also displayed are the Cut, Copy, Paste and Paste 
Unformatted buttons.  The latter two give you a choice of whether to paste with formatting or 
without.  Generally the Unformatted one is best coming from another software product because it 
gives your DecisionPad file global text style control. 
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Criterion Definition 

 

 
 

When defining a criterion the Name field and the Scale Field are required and the Note field is 
optional.  It is best if you keep the criterion name short and put any descriptive details in the note.  
The bold, italic, etc buttons apply to the notes field not the name, and will apply to whatever Text 
Style the criterion has been assigned. 
Criteria require a Scale selection in order for the criteria to become active in the decision.  Scales 
convert the evaluation words into a score or point percentage.  If you pull down the scale list you 
see the built-in ones plus any you have added: 

 

Pick a scale from the list or use the buttons above the list.  There is a pencil point to add a new 
scale, a pencil body to edit the selected scale, a pencil eraser to delete it or the camera to copy the 
scale.  You cannot delete a scale in use by other criteria but you can modify it.  Remember when 
you make modifications to a scale that is shared with other criteria will affect all the criteria using 
that scale.  The built-in comment scale cannot be edited. 

Normally you would set a scale when the criterion is created but you can defer this.  DecisionPad 
will remind you on Ok that the scale is not set though you have the option to save it anyway. 

For more on the role of scales see the Tutorial Guide and the Scale definition dialog below. 
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Criterion Group Definition 

 

 

 

Groups allow you to build a hierarchy for criteria or other groups in an outline-like format.  They can 
be nested as deeply as you wish, in effect creating what some call an Analytic Hierarchy. 

When defining a criterion group the Name field is required and the Note field is optional. It is best if 
you keep the criterion name short and put any descriptive material in the note.  The bold, italic, etc 
buttons apply to the Note field not the Name field, and will apply to whatever Text Style the group’s 
note has been assigned 
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View Properties Definition 

 

This is a multiple-tab dialog with many similarities between the matrix and report views, though 
some tabs or controls will come and go depending on the view. 

 

Labels: 

The first tab covers the labeling of the view with optional title, a paragraph of explanation and 
footer.  These will show in any printout, but will only show for reports on the editing screens.  The 
buttons for text styles are pencil point adds, pencil body edits and camera copies. 

 

Layout: 

The layout tab places the logo, if desired, selects the text style to use for the body and some 
settings that will vary depending on the view type.   
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Matrix Layout: 

Here the matrix type allows selecting Show Impact Arrows for the up/down arrows to mark 
the cells most affecting the decision (see the Tutorials) and/or Show Sparks which shows a 
small bar graph of the score for each cell. 

                               
Report Layout: 

For any of the reports you can choose which notes to show: 

 

Scores: 

For the Scores report you can also select whether to show them as Bars or as Scatterplots: 

 

The bars show the values for each criterion and alternative as the values convert to scores 
and then for the total scores: 

 

By showing the ranges that result from uncertainty you can see when an alternative has 
come to dominate regardless of the question marks.  Here Fred’ Iron Works overlaps 
Gate’s by Sally.  Until some of the unknown criteria are resolved you do not know which is 
best. 

The scatterplot option can be a good way to quickly show the strengths and weaknesses of 
the options on pairings of criteria: 
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Unknowns cause the markers to plot outside the score range square.  If both criteria are 
unknown the markers plot off the upper right corner.  If one is unknown it will plot at the 
other criterion’s value just outside it’s known axis.. 

 

Individual Alternatives: 

The Individual Alternatives report shows the results on a page or two for each alternative, 
which might be used to discuss the evaluation with each vendor or employee.  It is 
controlled by: 

 
 

Alternatives/Musts/Weights: 

For control of alternatives in the report or matrix go to the Alternatives/Musts/Weights tab.  This tab 
give you control over how the alternatives appear in the report or printed matrix, how they are 
sorted and numbered.   

   

The alternatives tab will often contain controls for weights and/or must haves.   

The Sort Rules are listed in the upper-left corner, including Sort by Criteria which uses the scored 
values of that criterion as the sort basis.  The sort rules are also controllable from the right-click 
popup menu inside the Matrix. 

The Show area controls how labeling is done, such as with numbers or labels. 

The Selection areas have a list of the items which the Matrix or Report can present.  In general 
there will be a list of the possibilities.  Any with a filled-in green marker are going to be shown; 
those without a marking square will be hidden.  The buttons on the right let you either show or hide 
everything, or selectively change the item selected. 

Note that the selection list works like an “opt-out”.  In other words when you add an alternative it 
will be shown in all views unless you explicitly say otherwise. 
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Criteria/Scores/Ranks: 

 

The Critera/Scores/Ranks tab gives you control over which items appear in the report or printed 
matrix, how they are sorted and numbered.  The criteria tab will often include the score and/or rank 
items. 

The Sort Rules in the upper-left are self-explanatory. 

The Show area controls how labeling is done, such as with numbers or not.  Without criterion 
groups your numbering choice is Yes or No.  With criterion groups you can chose to show the Full 
outline-number like 1.2.3 or just the criterion’s Own number within its group like (3). 

The Selection areas have a list of the items which the Matrix or Report can present.  Any with a 
filled-in green marker are going to be shown; those without a marking square will be hidden.  The 
buttons on the right let you either show or hide everything, or selectively change the item selected.   

The selection list works like an “opt-out”.  In other words when you add a criterion it will be shown 
in all views unless you explicitly say otherwise. 

The Scores Report, non-scatterplot, is a special case in that it has a Show Total Scores Only 
option.  This overrides the selection and the opt-out nature of new items.  Combined with sort 
alternatives by ranking, this makes a nice summary of the decision conclusions. 

If you bring up the View Properties for the default Matrix, view number 1, you will see that the 
selection options are not available.  This base matrix is the primary way of interacting with the 
decision structure which becomes confusing if things are hidden; it always shows all the rows and 
columns.  To show subsets make a new matrix view and use the selection tools for it. 

The Tutorial Guide has examples of using these controls. 
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Scale Definition 

 

Scale definitions use a two-tab dialog.  The first tab General applies to any scale: 

 
The General tab has fields for a required unique Name and an optional Note. It is best if you keep 
the scale name fairly short and put any descriptive details in the note.  The bold, italic, etc buttons 
apply to the notes not the name, and will apply to whatever Text Style the scale’s note has been 
assigned. 

The General tab also allows you to define the Scale Data Type.  There are 5 basic types of active 
scales Keywords, Numbers, Dates-Times, Rating and Forced Rank (the Comment scale is built-in, 
un-scored and not editable).  Each of these has its own tab which will appear when you chose that 
Scale Data Type radio button when in the General tab. 

The screens for each Scale Data Type shown below utilize the default 0-to-10 scoring range.  If 
you want to change the default score range go to Project > Scoring.  If you decide to use points 
instead of number or word weights then the dialogs below would show the percentage of the 
criterion’s possible points to be given each value. 
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Keyword Scales: 

 
Keywords are like the Excellence scale shown here.  On the right side you have the Keyword List 
in the order they will appear in matrix pulldown lists.  Above the keyword list you have Add, Insert, 
Delete, buttons that allow you to add new words to the end, insert in the middle or delete them.  
You can also move the words up or down in the ordering with the Up and Down buttons.  Edit the 
labels by typing directly into the label column. 

On the left you chose the Scoring Rule for this scale.  Here the First Word Highest Score is 
selected and the score range is automatically spread across the other boxes with the first word in 
your list being the highest score.  As you edit the Keyword List the scores will remain with the first 
word in the list being the highest score.  The same idea applies to the First Word Lowest Score 
option.   

The third choice, Set Score for each Keyword, let’s you set scores individually by typing values into 
the Score column of the list.  The values must be within the overall range but otherwise can be 
whatever you wish.  For example, the built-in Yes/No scales do not use the whole score range: 

 

Typically when people set up subjective scales they do not use the full range in practice – we 
generally avoid saying “unacceptable” -- hence the 2 and 8 for the Yes-No built-in scale above. 

There are also times when you do not want equal steps, a “non-linear” utility curve, so you need to 
set the steps directly.  The last use is where the middle is better or worse than the ends, what 
might be termed a “Goldilocks” scale. 
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The Graph button provides a quick check on the scale settings.  Here are some samples of what 
will pop up for Excellence 5 levels, Disagree 5 levels and a ‘Goldilocks’ scale: 

        

 

Number Scales: 

 
With Number scales the Set Scores choices determine the scoring.  How this looks depends on the 
setting in the Scoring Rule.   

Set Two End Points says what number gets the highest score and which the lowest.  The numbers 
can be fixed, like the 0 above, or floating with Max or Min. 

Selecting the End and Ratio rule gives this structure: 

 

This scale might say something like “the fastest number is best, whatever it turns out to be, and 
half of that gets the lowest score”.  Remember that importance of a criteria in the decision is 
another matter, expressed by the weights in your decision matrix. 
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The third Scoring Rule lets you set breakpoints for a shaped relationship. 

 

This draws a rough curve of score or utility versus number.  For numbers between -15 and 3 the 
score would be a declining straight-line between 8 and 5, and so forth. 

For any scoring rule, when a number is above or below the ends, then it gets the end’s score.  
Thus if 1200 was assigned the highest score of 10 then anything above 1200 would also be scored 
10. 

You should set-up number scales carefully to properly represent the utility of various numbers, with 
special caution using Min and Max.   

The Format section controls how the numbers will be shown, such as $1,234.56 set above, or 23% 
or (432) €.  The Symbol/Units entry can be with or without one space.  You can either type number 
values into the matrix as a plain number or with the formatting; other combinations will be rejected.  
Remember that Windows has a utility called Character Map that will help you find special 
characters not on your keyboard. 

The Graph Button shows the scoring; here are some examples: 

        

 

When the scoring ends on a particular value then the graph reminds you that values above or 
below that value will be assigned the ending score.  Thus an 11 gets a score of 0 and a -6 gets a 
score of 10 in the middle 9 to -5 example.  The last example is for the non-linear scale. 

Minimum and Maximum are very handy but should be used with care as they can understate or 
overstate the utility differences between alternatives.  This is particularly true when there are 
unknown values that you may want to leave in if the decision otherwise seems settled.  These 
issues are covered in the Tutorial Guide with examples.
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Date-Time Scales: 

Date-Time scales follow the same idea as the Number scales above. 

 

These are straightforward, basically taking the time differences in seconds.  When the dates are 
listed as month and year, the 1st of the month is automatically used for the computations.  

 

Rating Scales: 

A Rating scale has fixed end points like the -3 and +3 here.  It is very similar to the Keyword scale 
and has the same approach to Scoring Rules. 
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Forced Rank Scales: 

The Forced Rank scale sets the Number of Rank Levels and some optional Ranking Rules. 

 

  DecisionPad will apply the rules in several ways:   

• If the rank values for a criterion do not follow the rules then all the alternatives will be 
scored as if they were unknown. 

• In the Matrix view a criterion with rule violations will have a colored row label.  Hovering 
over that criterion will popup a note of which rule(s) are not met. 

• The Value Button Set screen will show whether the values are in compliance, which makes 
this screen the most convenient way to set rankings for a lot of alternatives  (for more 
information on Value Button Set see p. 15). 

Otherwise ranking is very similar to the Keyword scale with the same approach to Scoring Rules 
and similar caveats about setting appropriate scores.  With forced ranks, give some thought to 
whether alternatives that are not in the top rankings deserve a 0 score, the 4+ case above.  
Perhaps the scoring should be set for a narrower range instead of using the automatic 
assignments. 
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Text Style Definition 

 
Text Styles are reusable descriptions of fonts to be applied in the various views.  If you edit a Text 
Style, all the places that use that Text Style will change appearance.  4 styles are built-in: Matrix 
Style, Report Style,Title Style, Footer Style.  These styles can be edited but not removed.   
 
Here is the default setup for the footers, a 9-point italic Arial font. 

 

   


